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Civil 3D Sheets Sets for FDOT Plans Production

This session is will focus Civil 3D Sheets Sets for FDOT Plans Production. We
will explain and demonstrate how to create and manipulate an FDOT Sheet Set
(..dst) file. We will create and edit fields to make a custom sheet or edit the
topics/fields to suits specific needs for FDOT title blocks.

Software prerequisites:

»The most current/latest version of the FDOT Civil 3D State kit should be
installed.

User prerequisites:

»Should have a good understanding of AutoCAD and a basic understanding of
AutoCAD Civil 3D.
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Civil 3D Sheets Sets for FDOT Plans Production

Session Objectives:
»What is the Sheet Set Manager?
»What are Sheet Sets and How Do | Use Them?

»How does the FDOT C3D State Kit utilize the Sheet Set Manager?
* How to create an FDOT Civil 3D project.
* Create a new Sheet Set file from an existing template .dst.
* Import existing and new layouts/sheets into Sheet Set Manager.
Organizing your sheets.
Plotting using page setups to PDF, DWF or a Plotter.
Creating Archive/Transmittal Sets
»How to go back and edit data in a Sheet Set file.
»Exercise: Use Sheet Set fields to automate the insertion of title block text.
» Exercise: Use Drawing Properties fields to automate text.
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Civil 3D Sheets Sets for FDOT Plans Production

»What is the Sheet Set Manager?

* The Sheet Manager manages layouts in your drawing files by considering each layout to
be a “sheet” that is part of that “sheet set”. Whether the layouts are all in one drawing
file or distributed among many drawings, you can manage and make changes to them all
through the Sheet Set Manager.
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Civil 3D Sheets Sets for FDOT Plans Production

»What are Sheet Sets and How Do | Use Them?

* A sheet set is a .dst file that contains the properties of the sheet set. You start with
drawings that have model space content; these are your resource drawings. One layout
for each drawing becomes the sheet in the sheet set. Therefore, a sheet set is a collection
of layouts, one for each drawing.

* Sheet Sets help us keep track of files that are associated with our project.

laster 3

Sheets
=, Master Sheet Set
= & Roadwawbianc
{ Collapse
v
Mew Sheet...
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* Number or renumber them ¥ MNewSubset.,

Vi Import Layout as Sheet...

* Organize them in Subsets

Y Rename Subset...

* Plot and publish them | Remowesust

e 0 h Publish
pen t em Y eTransmit...
v

e eTransmit them §  insert Sheet List Table..
B Signil roperties...
b ZIP them |!|j Si;ﬂﬁll.'.m.ll.llrll

| Intelligent Transportation System (ITS) Plans Publish Sheets in Subset 3
&) Lighting Plans

)| Structures Plans Edit Subset and Sheet Publish Settings...

&) Utility Work by Highway Contractor Agreemer Publish in Reverse Order

BE| Right of Way Maps

Sheet List

Publish to DWF
Publish to DWFx

Publish to PDF

Publish to Plotter

Publish using Page Setup Override

Include Plot Stamp
Plot Stamp Settings...

Manage Page Setups...
Sheet Set Publish Options ...
Publish Dialog Box ...
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Civil 3D Sheets Sets for FDOT Plans Production

>How does the FDOT C3D State Kit utilize the Sheet Set’s?

* The FDOT Create Project application creates a Civil 3D FDOT project. The application can
setup the appropriate project directory structure and other required components such
as:

* Financial Project Information # (FPID)

* Project name

* Project description
* County
* Project manager e et of ot oo,
@ FDOT AutoCAD Civil 3D Project ©) FDOT MicreStation Project
* ....Many More. Parent Container Directory
The Parert Container Dlirectory is the root directory that holds your new and existing projects. Once you dlick the

"Create Project” buttan, your new project directory end its comesponding sub-directory structure willbe created
unde- this parent cortainer drectory.
7 o {Example: C:\e‘projects)

Pareni Direciory: C-ACivil 30 Projecie™ -

Financiai PFroject informaiion
Name The financial project information is used tc generzte the Fnancial Project Identifier (FPID). New projects will
always be created under the Parent Zontainer Direciory in a new directory ramed from the concatenation of the

financial project information felde.
Bl _FDoT2015.33D

B 193AEC e ri Dl e o Db T - a B e s - nn
D) Create 3D Deliverables fem: 123456 Segment: 7 Phase Group: 8  Phase Type: 9 Sequence: 00
[#F Create File Contract Information
@ - Mocde—rd ALoeb EEREREEER Mot i M- W oA o e Aozl ¥ MR [ B
Create Project Contract Mumber: 55555555 Contract Date:  Wednesday., il 22,2015 -
Y : ™1 In-House Contract IEDOTY
[# | ECSO GaToMeeting [0 in-House Cortract (FDOT)
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Civil 3D Sheets Sets for FDOT Plans Production

»How does the FDOT C3D State Kit utilize the Sheet Set Manager?

* Information from the creation of the project is carried over to the .dst file templates
during the FDOT Create Project process.

* You then use Civil 3D to create a new Sheet Set file based on the new or existing .dst
templates in the Data folder in your Project directory.

» Sheet Set properties are carried over to your new Sheet Set after creation.
* FDOT .dst files contains all of the sheet and sheet set properties you need for your

prOJECtS.
|| 12345678900
. _Meta_Info
| e Foadway Plan Set ;
. 3DDeliverables =
. Mame by
. Sher-ts =
. Admin I3
| Arch [ FDOT ARCHTECTURAL.dst RDEdWi!f S
.\ Block [ FDOT GEOLOGIST.dst ;j ) S
. Brinspect ‘ [=3 FDOT LANDSCAPE ARCHITECT.dst i B Signalization Slans
i Calculations [ FOOT MASTER SHEET SET TEMPLATE.dst i ) Intelligert Transportation System (IT5) Plane
S Em:ms [ FOOT ROW.dst & B Lighting Plans
. Con I &) Structures P
i Dats [=3 FDOT SURVEVING.dst =
. Drainage = &) Right of V
. EMO
.. Estimates

. Geotech
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Civil 3D Sheets Sets for FDOT Plans Production

»How does the FDOT C3D State Kit utilize the Sheet Set Manager?

* FDOT C3D State kit contains templates with intelligent title blocks that reference FDOT
standard and custom Sheet Set data.

Master Plan Set

Sheets
2, Master Plan Set
| MJ Roadway Plans
[% 1 - KE¥SHEE Master Plan Set
[F 2 - ROADWI

CheckedBy:

) Signing and Pay RIS
B Signalization Plifaiy e R=s
&) Intelligent Tran:REisYS
E| Lighting Plans [ty

5 St P A PROFESSIONAL OF RECORD:

P.E.z

B Utility Work by CountyMNumber3:
&) Right of Way M) EataEt
DrawingCheckedBy:

DrawnBy: ‘

DrawnDate: D[STR[CT
eSignatures MOTICE: THE OFFICIAL RECO
THE ELECTRONIC FILE SIGNED AND SEAL
61G15-23.003, F.A.C.
FDOTProjectManager: Mike Racca
FinalBy:

FinalDate:

Fiscal¥ear: <YV>

FPID1: 123455-7-89-00

FPID2:

FPID3:

Obsolete: NO

PORIMName: Mr, Engineer
POR2LicenseMumber: 12345
POR3Address: 605 SUWANNEE STREET
POR4City: TALLAHASSEE

PORS5S5tate: FL

PORGZip: 32301

BHEET SET MAMAGER
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Civil 3D Sheets Sets for FDOT Plans Production

»How does the FDOT C3D State Kit utilize the Sheet Set Manager?
* How to create an FDOT Civil 3D project.

1. Launch CreateProjectC3D. This application is installed with the FDOT C3D state kit.
It can be found in the installed application folder on the desktop or launch directly
from the Windows program group.

2. Verify that the Project Type is set to “FDOT AutoCAD Civil 3D Project” and the
Parent Director is pointing to the desire location. The primary information that
needs to be completed is the Financial Project Identifier and the Project
Description (General Description). These fields will turn green when the amount of
information entered is satisfactory. When complete select “Finish”.

3. You will then receive a Create Project verification notice. If everything looks
correct, click “OK”.

PLDDS - Create IDOT Project (Version 4.2.4.22) — S
r a
5 . T T
Projeut T,.m Create Project i W
) ;
Ths spplcaiion cn crect boih ACCAD s Micro-Seaion [DOT projs, Dy sefecintretype of proect you S —
wish to create. (h pplic: setup the appropriate dmm ory structure and the other required componerts
e e
@ FDOT AutoCAD Civil 3D Projoct =) FDOT MicroStation Projcct .
o Youareaboutto create a new FDOT "AutoCAD" Project based on the
Parent Container Directory 1 P .
The Parent Container Directory is the root directory that holds your new and exdsting projects. Once you click the £ following information:
"Create Project” button, your new project directory and its Gomespanding sub-drectory structu o ol e et
under this parent containgr directory - - . _— . - s mm o
(Examole: C:\e\brojects) Project Directery: C:ACivil 3D Projects\12345678911
Parent Nimctory.  CACivil 2D Projects\. b =)
2l Project i Financial Project Id: 123456-7-80-11
The francid orfect fomgon s ueed Benerate he Fnancal Proect derifier (PID). New pogets il
e e B B e ST e o T G
financial project information fields Contract Number:
hom: 123456 Segment: |7 Phace Group: £ | Phaee Type: 9 Saquenca: 0
ol
—— - Contract Date: 5/14/2013
Contract Number- Contract Date:  Tuesday . May  14.2013  [J~ il
[ In-House Cantract (FDOT) Do you wish to continue?
2015 / | Project Descripti
| - \\ General Description -
4 j \"'Tl"/ - iL '\\ Re-surfacsing State Road Projsct i
| S ) [
|
esign Tramng ok | [ cancel |

crpo

Required Fields




Civil 3D Sheets Sets for FDOT Plans Production

»How does the FDOT C3D State Kit utilize the Sheet Set Manager?

4. In the following dialog boxes, complete as much information as possible by moving
through the tabs on top. The County, Road Number and the Project Manager
information is vital for all sheets to be created. Select “Save Changes”. Select “OK”
to the dialog boxes that follow to confirm changes and updates to Sheet Sets,
Projects Summary Report and to confirm that the AutoCAD project has been
successfully created.

' PEDDS - Projectld XML Editor 4.2.4.22 = % | PEDIDS - Projectld ¥ML Editor 4.2.4.22 [E=mpe )
Identification |Location | Digciplines I BEridges | Description | Managementl | Identfication | Location | Disciplines | Bridges | Description | Management |
Project Information Project Designation
Project Path: |C-\Civil 3D Projects\12345678910 Designation: | Road Reconsiniction

Project Locations
Project Key: |EBD91435-540F-4B18-893D-ED16628453E9

County Name Section SubSection Begin Mile Post End Mile Post
Leon i : 100 EX
Financial Project Information K !
*

Federal Aid Number
Route: Improvement: FAM Type: [A: STATEWIDE '] ‘

Contract Information

|
tem: 123456 Segmert: 7 Phase Group: 8 Phase Type: 9 Sequence: 10 l—z' ‘
|
|

Sigie Road Numi

State Road Number
Contract Number: Cortract Date:  Wednesday,  May 15, 2013 E- ; 20
2] In-House Contract (FDOT) *
Project Usage
< Back Next > Cancel | [ <Back | [ Nets
15 Ready for Input Ready forlnput
A1\
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Civil 3D Sheets Sets for FDOT Plans Production

»How does the FDOT C3D State Kit utilize the Sheet Set Manager?
* Create a new Sheet Set file from an existing template (..dst).

1.

15 .
)es:gn Trammg

Access Sheet Set Manager (SSM) by click the Sheet Set Manager icon on the Home
Ribbon > Palettes Tab. Type SSM at the command prompt to launch. Its also one of
the few commands that you can launch from the quick access tool bar with out

have to open a drawmg first.

EXPRESSMENU

Home = Insert SSMAUTOOPEN

Open SSM and select the drop-down arrow to pick the “New Sheet Set...” option.

When the Create Sheet Set wizard opens, select to use “An example sheet set”

then select Next>.
Create Sheet Set - Begin (XN

[| FOOT MASTER SHEET SET TEMPLATE ¥ @& |- b begn
Dief it Shesst Set : Sheet Set Example
Creste a sheet set using

 FOOT MASTER SHEET SET TEMPLATE - Shieet Set Delais
) Canfinr @ An example sheet set é

() Sxisting drawings

Shast Lisk

sheet al provide m orgen nizational

n w sheet optio rwnH
nct copy any sneets from the exisi shease Pﬂiryu create
sheet s=: with this opion yﬂ arlmp ot layoLts or create ey
individuzlly

Shuat; Wiews

<Beck [ Nea>
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Civil 3D Sheets Sets for FDOT Plans Production

»How does the FDOT C3D State Kit utilize the Sheet Set Manager?

4. Select the “Browse to another sheet set to use as an example” and pick the ellipsis
button to browse to the FDOT MASTER SHEET SET TEMPLATE located in the data
folder of your project. Click “Next” when you return to the “Create Sheet Set” box.

5. Name your Sheet Set then select the ellipsis button to navigate to your project
location. Store the file in the \eng_data folder under the corresponding discipline
folder. Select “Sheet Set Properties” to add or edit the Custom Properties.

6. Click “NEXT, confirm the Sheet Set Preview setting and select “FINISH” when
complete. Your new Sheet Set will display in the Sheet Manager dialog box.

L L L eSS " Sheet Set Properties - Roadway Design )
s v R, o
| Sheet Set =

3edin . . . Name Roadway Design

= NName of new sheet sel: - Sheet set data file C:\Civil 30 Projects\22222222222\roadway\eng_data\Road...
Sheet Set Example Roadway Design e Description SR7 Resurfaceing Project. Leon County

Model view
b Sheet Set Details S orl Label block for views
e S (L Callout blocks
SR7 Resurfaceing Project. Leon Coutty - Page setup overrides file CAFDOT2012.C3D4Suppert\Plot\FDOT-pagesetups.dwt

| Project Control ™

| Project number

Project milestone
Store sheet set data file {,dst) here: - | Sheet Custom Properties =

] - CheckedBy

CheckedDate
Countyl Leon

glolo oo oloon
& oo (o g |
I=a

3

4

3

=

&

2000,

i BN strict «District Number>
e

V

' Design Trai
%” 9 %l o [ bets ] [ e &) (o= (e
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Civil 3D Sheets Sets for FDOT Plans Production

»How does the FDOT C3D State Kit utilize the Sheet Set Manager?
* Import existing and new layout/sheets into SSM.

1. Using the Create File application on the FDOT ribbon create a Key sheet file. Click
on the “Create File” icon under the FDOT tab. Follow the steps to create a new Key
Sheet file inside your current project directory under the Roadway Project folder.

Create File (v2.).2.0) Workspace: FDOT2015.C3D @
. . . Project: 1 [C\E\FrojectsiSheetSetClass\ 12345678900 | [ Seledt Projeat |
Confirm the Project path is correct. o .

Set Discipline = “ROADWAY” e Grup B[ Teadoy Desn T -]

File Tyoe:

Fi Ie G ro u p = ”Roadway Desjgn FiIeS”- Drainage Optonal Materials Tabulgtion -

Dhainaye Shuclure Guoss Seclions Pallenr Lines and Shapes

Drainage Structures - Existing

For File Type select “Key Sheet” Dranase Smctores Fropsed

Intersection-Interchange Details

. . . Intersection-Interchznge Profiles 1
Select the desired Project Coordinate System. E’E.%MdQ_‘

Latera Ditch Plan ard Profile Sheet
o . ” Mitigation Areas

Select “Create File”. Mot Fi for Plan Sheets

Motif File for Profile Sheets m

Plan ad Profile Sheets

Plan Sheet

Pond Cross Sections, Pattem Lines and Snapes

Pond Design

Profile Sheets

Projec: Layout Sheels

Projec: Motes

. Prujec. Prufile Layuou,

A Al i

Create

File OutputFile:  KEYSRDOZdwg

Create File Output Folder:  roadway™
Template: keysht dwt -Bmwse

Templste Path: datatemplatess

| / Coordinate Syatem: | FL East v 5
A1\ ’

Active Sile for Dpen: C:AE\Projects \Sheet SetClass' 12343678500 roadway \KEYSRDO1 .dwg

) ) . T
%ﬁes’gn Training 6[ ozere |
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Civil 3D Sheets Sets for FDOT Plans Production

>»How does the FDOT C3D State Kit utilize the Sheet Set Manager?

2. Located on the bottom of the .dwg file are several layouts. Select your desired
layout, right-click and choose Import Layout as Sheet...

FIOT.

Drafting Standard Setup...

Import Layout as Sheet...
Export Layout to Model...

Dock above Status Bar

3. Inthe Import Layouts as Sheets dialog box the layout that you right-clicked on, will
already be checked. You can browse for drawings at this point if there are other
layouts that you would like to import at this time. Select Import Checked when

Com plete' [ A Import Layouts as Sheets- ﬁ

Select drawing files containng layouts:

[ Browse for Drawngs. .. ]

A layout can belong to only one sneet set. If a layout already belongs to a sheet set, you
must create a copy of the layout to import it.

Drawing Nam= Layaut Mame Status Il
[ KEYSROO:.dwg Mor-FF w map Warning: this layout may belong
KEYSRDO.dwg FF w_Maps Warning: this layout may belong
|7l KEYSRDO . dwg Mor-FF no map Warning: this layout may belong L
[C] kEYsRDO . dwg FF no map Warning: this layout may belong| ™
[] KEYSRDO.dwg Landscape Warning: this layout may belong
[ KC¥SRDO . dwg Ligkting Warning: this layout may belong
[] KEYSRDO.dwg LightingFF Warning: thiz layout may belong —
[] KEYSRDO . dwg ITs Warning: this layout may belong
[] KEYSRDO.dwg ITS_FF Warning: this layout may belong

Prefix shee: titles with fle name

W ‘mport Checked ] [ Cancel ] [ Help
—_—

Ldwg ignal Warning: this layout may belong
5 [] KEYSRDO . Signal Narning: this layout may bel
201 . \—/ [ kFYsRO . dAwg SignalFF Warning: this layout may helnng
A [T kFYeRDO- . dwn Sinninn Warninn: thiz lavant mav helora ™
S ‘| m ] y
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»How does the FDOT C3D State Kit utilize the Sheet Set Manager?

4. Inthe SSM dialog box, select the new imported layout and drag it to your desired
subset category. Type “regen” at the command line to update your data text field

in your sheet.

hdaster Plan Set

Sheets
& Master Plan Set
= & Roadway Plans
(%L 2 - ROADWAY PLANS

24 KEVSRDOL - FF w_Maps

Signing and Pavernent Marking Plans

&) Signalization Plans

&|| Intelligent Transportation System (ITS) Plans
Lighting Plans

Structures Plans

= Litility Work by Highway Contractor Agreem
B g F Wiayw Mane
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> Using Sheet Set Manger to organize your sheets

* Examine options that allow you edit sheet names and numbers, remove sheets and even
rename your drawing file itself..

* To edit names and numbers in your title blocks and in the SSM, right-click on a sheet
name and choose Rename and Renumber.

Enter your desired name and number and the Next or Previous buttons to move up and
down the sheet list.

* You can also change the name of the file itself to match the new sheet set title. You
can only rename the file as long as you do not have it currently open.

To remove a sheet, right-click and choose Remove Sheet. You remove the sheet from
the list, but you are not deleting the file it self. You are only removing the shortcut.

i

| vy . P F
& Fename & Renumber

Sheets
i Master Sheet Set M wumber: sheet title:
= B Roadway Plans

KEYSR i
Open

1 KEY SHEET

Open read-only Layout name: = KEY SHEET

Mew Sheet... File name: KEYSROG1.dwg

Import Layout as Sheet...

Foider path: C:EProjectsiSheetSetiCiass| 12345678900 \Hoadway
Rename & Renumber...

Remove Sheet

Rename drawing file to match
Publish o
| Sheet title
2015 eTransmit... SR W T Crafw mth oot :
/ﬁ ?_4_‘7-/_;__ \\ MTPLR] Insert Sheet List Table...

By — &) Signing an

%esign Tra%ng.u\ :J Sigiqa.liz_ati( Proprties... i _ e [ == J [ P— ] [ Help ]
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» Using Sheet Set Manger to organize your sheet

* Populate and edit information from Sheet Set to Title Block sheet and edit Object Data
Fields.

* Two types of Object Data fields for SSM. Sheet Set Properties and Sheet Properties:
» Sheet Set Properties displays information specific to the selected Sheet Set.

 If it applies to all sheets in the Current Sheet Set select the
CurrentSheetSetCustom Field. Examples: City, State and Project #.

» Sheet Properties displays information that is specific to the selected sheet, such
as the sheet title, sheet number, and also display custom properties if any.

 If it applies ONLY to the Sheet on which the Field resides Select the
CurrentSheetCustom Field. Example: Drawn By, Revision, Date.

TIP! Empty Sheet Set Fields stay empty
Enter %%U in the property box to create

Data Fields appear in a drawing with a shaded empty data fields as opposed to dashes “--”.

background.

FDQOT Title Block Example

PROFESSIONAL OF RECORD:

NAME .©.7" = LICENSENUMBER
pisTRICT [

Fields left blank will
plot as dashes.

-l--

empty fields that

%%U Creates
‘ will not plot.
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» Exercise: Use Sheet Set fields to automate the insertion of title block text.
* Example below shows how to create a default Sheet Set and add custom sheet set fields.

Ty

1. Select the Home tab, and locate the Pallets panel. Click on the Sheet Set Manager icon.

2. Locate the drop-down menu at the top left corner and select New Sheet Set option to
create a new Sheet Set file.

3. When the Create Set dialog box opens, choose Existing drawings then click Next>.

Give the Sheet Set a name. The Description is optional. Select a location where the new
Sheet set data file (..dst) will be stored. Select the Sheet Set Properties button to access
the Edit Custom Properties option.

5. Inthe Custom Properties dialog box, select Add...

In the Add Custom Property dialog box, for the name value enter CITY, leave the Default
value, Value

7. For Owner, since this is a City value and will more than likely be used on multiple sheets
select Sheet Set. Repeat the same steps for STATE and ZIP.

2015 ‘ pd | AT
\\\\‘1\ ______ : r_'lr—*:—’_ — L-,\t\ b 8 i

Jesian Tr.awg‘wmtng:)ﬂlU




Civil 3D Sheets Sets for FDOT Plans Production
Q Add Custom Proper | |

Name:
cImY

5

Default value:

Value

Owner 7
6
() sheet oK i [ Cancel ] [ Help I

A ' Custom Properties

Sheet Set Detaild 1

Choose Layouts

Name Default Value Owner Add...

Corfimn CITY Value Sheet Set
STATE Value Sheet Set
iy Value Sheet Set

] [ | »

[ Edit Custom Properies. || [ ok | [ Cancel | [ Helb | [ OK ][ Cancel ] [ Help ]

|[ Sheet Set Properties ]l 2

<Back | MNet> | [ Cancel |

8. Click ok a few times until you return to the Create Sheet Set dialog box.
9. Click Next> to for Choose Layouts option.

10. Select browse, and browse for your drawing file that contains Mtext for your title block.
(note: you will not see the drawing file in the dialog box). Click ok.

11. Select the name of the Layout out Tab that that you want to import. Click Next>,
confirm you settings and select Finish.

12. Double click the name of your sheet that you just imported in your new Sheet Set.

5
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Civil 3D Sheets Sets for FDOT Plans Production

Locate the Mtext you wish to convert to Data fields in your title block. Double click on
the Mtext to enter Text Editor mode. You will see the ribbon change accordingly.

Highlight the text, and choose Field from the Insert Panel.

In the field dialog box, under the Field Category drop-down menu choose, SheetSet
then choose CurrentSHeetSetCutom under Field Names.

Under Custom property name you will see the custom Data fields you created. Choose
CITY then click OK.

Select Close Editor on the Ribbon.

The word Value will appear in your Mtext with a grey shade behind it representing a
data field.

To edit the field right-click on the Sheet Set title name in the Sheet Set Manager and
choose properties.

Locate Sheet Set Custom Properties category, click in the Colum on the left for CITY and
enter in your desired City Name. Click OK to close out the dialog box.

Type “regen” at the command like to see you text up with the new City name.
Repeat the same steps for STATE.

| W e
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» Use Drawing Properties fields to automate text.

* Exercise: Example below shows how to use the Drawing Properties feature to assign
names and values to create custom properties.

1. Choose the Application button> Drawing Utilities> Drawing Properties or choose
File>Drawing Properties to open the Drawing Properties dialog box.

2. Click the Summary tab. If you can use any of these properties, start here. For example,
you can use the Title field for the drawing name.

3. To add a custom field, c lick the Custom tab. Use a custom field for content that cannot
use one of the fields that come with AutoCAD.

4. Click the Add button. In the Add Custom Property dialog box, enter a field name and
value and click OK.

General | Summary | Statistics | Custom

|

Custom properties “
——

Mame Walie | Add | 1|

Mame  Vake L o Add. | I

1=

|

L Caioa L |

‘s T———T Im

A Add Custom Property L] ‘I‘

Custom property name: It

CreatedBy ‘I‘

N

e

’/ esign Traiq;'};éuu\
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5. Repeat Step 4 for all of your custom fields.

6. Click OK to close the Drawing Properties dialog box.
To insert fields, start the MTEXT command and define the bounding box (or use the
ATTDEF command to create an attribute definition).

8. In the Text Editor (or Value or Default text box of the Attribute Definition dialog box),
right-click and choose Insert>Field. You can do the same in a table.

9. To find your custom fields most easily, choose Document from the Field Categories
drop-down list. You’ll see all your custom fields listed.

10. Choose the field you want, choose a format, and click OK.

11. Repeat Steps 7-10 for all your custom fields.

12. To use any of the fields that come with AutoCAD, again choose Insert>Field, choose a
different category, field, and format.

200, |\
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Thank You!

Questions?

Email me:
Mike.Racca@dot.state.fl.us

The Civil 3D FDOT State kit is available for download at:
http://www.dot.state.fl.us/ecso/downloads/software/FDOT2015CADDSoftware.shtm

MIKE RACCA Florida Department of
CADD Applications Support FD Oﬁ TRANSPORTATION
Florida Department of Transportation (ECSO)
Email: Mike.Racca@dot.state.fl.us

20 15 .
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